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Meeting Objectives )&

The Objectives for today’s meeting:

 Review the two new screens in CMIPS
v' Blind or Visually Impaired screen

> Create
»  Modify
> View

»  History screen
v' BVI Timesheet Release/Reject History screen

» Recipient Summary Characteristics Listing Report Changes
* Large Font Timesheet

* NOA Options

» Telephone Timesheet System (TTS) Overview




Background »:

The purpose of this webinar is to inform counties of additional resources that will be
available to them, as part of their ongoing responsibility to ensure effective
communication with Blind and Visually Impaired (BVI) In-Home Supportive

Services (IHSS) applicants and recipients by providing alternative formats for

written program documents and materials. As communicated in ACL 15-60, these
alternative formats will include making required recipient forms, notices of action (NOAS)
and timesheets available in large font size, Braille, and compact disc (CD) audio and data
files to allow BVI applicants and recipients the ability to read/listen and/or

complete these documents.

IHSS recipients are responsible for reviewing and approving their provider(s) timesheets
prior to submission of the timesheet for payment processing.

To assist BVI applicants and recipients, the CDSS is now making reasonable
accommodations to IHSS BVI applicants and recipients to ensure meaningful access to the
IHSS Program as required by the Americans with Disabilities Act (ADA).

CMIPS has been modified to implement some of these accommodations.

1111
I




CMIPS Blind and Visually
Impaired Screens - SOC 295




Blind and Visually Impaired ))) -

Screen

CASES

5 Home
Evidence
5 Medi-Cal Eligibility
8 Contacts
[Y Dnsaster Preparedness
[ Blind or Visually Impaired
8 Authorization
= Modes & Hours
Providers
Overtime
= Timesheet
= Payroll
Case Maintenance
Administration
= Quality Assurance
8 Unannounced Home Visit

HEHHBEEHERK

[ Forms/Correspondence
[ Recent Changes

4 Motes

[4 Tasks

Blind or Visually Impaired:

Mew History
- i i ! - -
Action —— - e Timesheet Option
Impaired
View | Edit BElind Telephonic System

When the “Blind or Visually Impaired” link is selected from the Cases Left
Navigation, the Blind or Visually Impaired screen is displayed. This screen

displays the current, active BVI record associated with the case.



Create Blind or Visually

Impaired screen

»”:

CASES Blind or Visually Impaired:
E s B ricv: tistory
E = Evidence
[ Medi-Cal Eligibili Acti z lin '”""I isusll Ti ;
Medi-Cal Ehgibility ion i i n
[ Contacts
[f Disaster Preparedness View | Edit Blind Telephonic System

G Blind or Visually Impaired
& Authorization

E B2 Modes & Hours

E 2 Providers

E B2 Overtime

When the “New” link is selected from the Blind or Visually Impaired screen, the
Create Blind or Visually Impaired screen is displayed. This screen is used to

create a new BVI record.

=]

Create Blind or Visually Impaired:
Save Cancel
Create Blind or Visually Impaired
* Blind or Visually Impaired: ‘ V|
* Noice of Action Option: | V]
* Timesheet Option : | v|

Recipient Authentication Number; | |
* 1HSS Required Forms Option: | v




SOC 295 - New Section 7 »)
Option - Blind

Create Blind or Visually Impaired:

Create Blind or Visually Impaired A

*Blind or Visually Impaired: ‘B“ﬂd ” Recipient Authentication Number: | |
* Notice of Action Option: | V| * IHSS Required Forms Option: | V|

* Timesheet Option: ‘ M ‘

These options reflect the same options listed on the SOC 295 Form, section 7.

If Blind is selected on the "Blind or Visually Impaired" field, then the following
accommodations can be chosen:

* Notice Of Action Option - No Accommodation is Needed, Braille Documents,
Audio CD, Data CD

* |IHSS Required Forms Option - No Accommodation is Needed, Braille
Documents, Audio CD, Data CD

« Timesheet Option - No Accommodation is Needed, Telephonic System

Note: The RAN field is not pre-populated field. If a blind recipient chooses TTS for
Timesheet Option then they will be required to choose a 4-digit numeric RAN. The
county worker will be required to enter this number in the RAN field.




SOC 295 — New Section 7 M)
Option - Visually Impaired

Create Blind or Visually Impaired:

Create Blind or Visually Impaired B
* Blind or Visually Impaired: | Visualy Impaired * Recipient Authentication Number: | |
* Notice of Action Option: Vv * IHSS Required Forms Option: v

* Timesheet Option : Vv

Save Cancel

These options reflect the same options listed on the SOC 295 Form, section 7.

If Visually Impaired is selected on the "Blind or Visually Impaired" field, then the
following accommodations can be chosen:

* Notice Of Action Option - No Accommodation is Needed, Large Font NOA,
Audio CD, Data CD

« |HSS Required Forms Option - No Accommodation is Needed, Large Font
Documents, Audio CD, Data CD

 Timesheet Option - No Accommodation is Needed, Large Font Timesheet




Modify Blind or Visually

&

Impaired screen

CASES
0O Home

E = Evidence
O Medi-Cal Eligibility
0O Contacts
O Disaster Preparedness
0O Blind or Vizually Impaired
O Authorization

[ 2 Modes & Hours

E 2 Providers

E B Overtime

Blind or Visually Impaired:

New History
ACtion lir i r Wi 1l Ti t ——
view | Edit _ Blind Telephonic System

When the “Edit” link is selected from the Blind or Visually Impaired screen, the
Modify Blind or Visually Impaired screen is displayed. This screen is used to

modify an existing BVI record.

Modify Blind or Visually Impaired:
Save Cancel
Details A
Created By:
From: 5/5/201509:29 To: 12/31/9999 12:00

Modify Blind or Visually Impaired A
* Blind or Visually Impaired: | 8ind v| Recipient Authentication Number: [1951 |

* Notice of Action Option: | No Azcommodation is Needed v| * IHSS Required Forms Option: | No Accommodation is Needed v

* Timesheet Option : | Telephoric System v




View Blind or Visually ») -
Impaired screen

CASES Blind or Visually Impaired: .
0 Home Mew History
Evidence Blind or Visually Notice of Acti
: o ) ind or Visua _ ) Notice of Action
L = .
[ Medi-Cal Eligibility Action Imoaired Timesheet Option Option
(3 Contacts .
) . . - . Mo Accommodation is
[ Disaster Preparedness — View | Edit Blind Telephonic System Needed

(3 Blind or Visually Impaired
[% Authonzation

When the “View” link is selected from the Blind or Visually Impaired screen, the
View Blind or Visually Impaired screen is displayed. This screen is used to view a

current or previous BVI record.

View Blind or Visually Impaired:
Edit Inactivate Lock Recipient Authentication Number Lock Recipient Authentication Number History Close

&

Details

Created By:

From: 7/17/2015 14:41 To: 12/31/9999 12:00

=

View Blind or Visually Impaired
Blind or Visually Impaired: Elind
Notice of Action Option: Mo Accommodation is Needed
Timesheet Option : Telephonic System
Edit Inactivate Lock Recipient Authentication Number Lock Recipient Authentication Number History Close

Recipient Authentication Number: 6671
IHSS Required Forms Option: No Accommodation is Needed




View Blind or Visually ») =
Impaired screen (cont’d)

View Blind or Visually Impaired:

Edit Inactivate Lock Recipient Authentication Number Lock Recipient Authentication Number History Close

Details A
Created By:
From: 7/17/2015 14:41 To: 12/31/9999 12:00
View Blind or Visually Impaired A
Blind or Visually Impaired: Blind Recipient Authentication Number: 6671
Notice of Action Option: No Accommodation is Needed IHSS Required Forms Option: No Accommodation is Needed
Timesheet Option : Telephonic System

Edit Inactivate Lock Recipient Authentication Number Lock Recipient Authentication Number History Close

The View Blind or Visually Impaired screen contains the following links:

« Edit — this link to be used to modify the BVI record

* Inactivate — this link to be used if the recipient wants to disenroll from the
BVI options

 Lock Recipient Authentication Number — this link to be used only by the
Telephone Timesheet System Assistance Line Agents to lock the RAN if the
callers couldn’t authenticate themselves (not for County use)

 Lock Recipient Authentication Number History — this link to be viewed by
users to track the RAN lock history

« Close - this link to be used to close the current page



Blind or Visually Impaired M) -
History Screen

CASES Blind or Visually Impaired:
L Home Mew History
E B Evidence -
& Medi-Cal Eligibility Action BI._I:I“d ;:'r V! - It Timesheet Option
O Contacts
5 Disaster Preparedness View | Edit Blind Telephonic System

O Blind or Visually Impaired
O Authornzation

= Modes & Hours

= Prowviders

2 Owvertime

When the “History” link is selected from the Blind or Visually Impaired screen, the
Blind or Visually Impaired History screen is displayed. This screen lists the
history of BVI records associated with the case. The default sort displays the
most recent BVI record at the top of the list.

Blind or Visually Impaired History:
Close
< = Recipien s - =
2 Blind or Visually _gu : z Notice of Action IHSS Required Forms
gired Timesheet Option ptio ptio From To
Action e A@gm nrﬂglgn Timesheet Option Option Option Created By From To
View Blind 6671 Telephonic System Audio CD Data CD 5/26/2015 13:44 7/17/2015 14:41
Close

I

View Blind or Visually Impaired:

Lock Recipient Authentication Number History Close

Details A
Created By:
From: 5/26/2015 13:44 Ta: 7/17/2015 14:41
View Blind or Visually Impaired A
Blind or Visually Impaired: Blind Recipient Authentication Number: 6571
Motice of Action Option: Audio CD IHSS Required Forms Option: Data CD
Timesheet Option : Telephonic System

Lock Recipient Authentication Number History Close




County User View &

County IHSS workers will have view-only access to the BVI Timesheet
Release/Reject History screen. This screen captures timesheet
information that was processed through TTS.

The BVI Timesheet Release/Reject History screen can be accessed by
all users; however, action can be taken only by TTS Assistance Line
Agents to update timesheet information.

If the recipient chooses to speak with a TTS Assistance Line Agent, and
the recipient wants to approve or reject the timesheet after reviewing all
the hours, a TTS Assistance Line Agent will take the action requested by
the recipient calling.




BVI Timesheet Release/Reject M)

History Screen

View Timesheet:
| | [ History | [ BVI Timesheet Release/Reject History | —
Manage E]
?Eh] View Image View Payment Details
Details &
Provider Number: Provider Name:
Recipient Number: Recipient Name:
Type: IHSS Arrears Remaining Hrs (HH:MM): &87:01
Status: Processed Status Date: 8/3/2015
Print Method: Print Now on CMIPS II Printer Print Date: 7/27/2015
Service Period From: 7/16/2015 Service Period To: 7/31/2015
Timesheet Number: Legacy Timesheet Number:
Received Date: 3/3/2015 Mode of Entry: TPF
Large Font Timesheet: No
BVI Recipient Timesheet Processing Details A
Processed Through Telephonic Solution: Yes Processed By BVI Assistance Line Agent: HNo

When the “BVI Timesheet Release/Reject History” link is selected from the View

Timesheet screen, the BVI Timesheet Release/Reject History screen is

displayed.

BVI Timesheet Release/Reject History:

| View Timesheet Details | | History | | |
Close

Entered By Creation Date Text

SUpEruser 8/3/2015 14:07 Released




Modified Screen List D)) &

The CMIPS screens listed below have been modified to display BVI
enrollment options:

Timesheet Search screen

View Timesheet screen

Timesheet History screen

Forms and Correspondence screen




Timesheet Search Screen

»”)

Timesheet Search:

Search Criteria A

Service Period A

FomDate: | |i] ToDate: | (]
Timesheet Number: | |
Search Reset <« Search Previous 6 Months Search Next 6 Months ==

Search Results (Number of Ttems: 8) A
Action Timesheet Number  Provider Number  Provider Name Service Period From  Received Date  Hours Claimed  Type Large Font Timesheet | Status
View Image 1045653103 4/1/2015 4/16/2015 §7:00 TH3S Arrears | No Processed
View Image 1046216544 4{16/2015 5/4/2015 84:30 THS5 Arrears | No Processed
Yiew Image 1046376080 5/1/2015 5/18/2015 86:00 THSS Arrears | No Processed
View Image 1047633675 5/16/2015 B/3/2015 96:15 IHSS Arrears | No Processed
View Image 1048261417 8/1/2015 6/17/2015 86:00 THSS Arrears | No Processed
View Image 1048304218 6/16/2015 7/2/2015 55:30 TH3S Arrears | No Processed
View Imaqe 1049337549 7/1/2015 7/16/2015 105:55 IHSS Arrears | No Processed
View Image 1049343052 7/16/2015 8/3/2015 100:00 THSS Arrears | No Processed

When the “Timesheet Search” link is selected from the Cases Left Navigation

pane, the Timesheet Search screen is displayed. The “Large Font Timesheet”
indicator has been added to this screen.




View Timesheet Screen

19
Search Results (Number of Items: 4) A
Action Timesheet Number Provider Number  Provider Name Service Period From Received Date  Hours Claimed  Type Large Font Timesheet Status
View Imaqge 1046876080 5/1/2015 5/18/2015 56:00 IHSS Arrears No Processed
View Imaqge 1047633675 5/16/2015 6/3/2015 96:15 IHSS Arrears  No Processed
View Image 1048261417 6/1/2015 6/17/2015 36:00 IHSS Arrears Mo Processed
View Image 1048804218 _ 6/16/2015 7/2/2015 95:30 IHSS Arrears  No Processed
“wT ”o H ,
When the “Timesheet Number” link is selected from the Timesheet Search screen,
the View Timesheet screen is displayed. Three new indicators have been added to
this screen.
View Timesheet:
| | [ History | BVI Timesheet Release/Reject History
Manage A
% View Image View Payment Details
Details A
Provider Number: Provider Name:
Recipient Number: Recipient Name:
Type: IHSS Arrears Remaining Hrs (HH:MM): 40:56
Status: Processed Status Date: 7/3/2015
Print Method: Print Date: 6/17/2015
Service Period From: 6/16/2015 Service Period To: 6/30/2015
Timesheet Number: Legacy Timesheet Number:
Received Date: 7/2/2015 Mode of Entry: TPF
Large Font Timesheet:
BVI Recipient Timesheet Processing Details A
Processed Through Telephonic Solution: Yes Processed By BVI Assistance Line Agent: No
A
HH:MM HH:MM HH:MM HH:MM
SUN : 00:00 SUN 21: 00:00 SUN 28: 00:00 SUN: 00:00
MON : 00:00 MON 22: 0B:00 MON 29: 00:58 MON : 00:00
TUE 16: 08:00 TUE 23: 00:00 TUE 30: 00:00 TUE: O
WED 17: 00:00 WED 24: 08:00 WED : 00:00 WED :
THU 18: 08:00 THU 25: 00:00 THU : 00:00 THU :
FRI 19: 00:00 FRI 26: 00:00 FRI : FRI :
SAT 20: 08:00 SAT 27: 00:00 SAT : 00:00 SAT :
Weekly Total: 24 : 00 Weekly Total: 16: 00 Weekly Total: 00 : 56 Weekly Total: 00 : 00
Hours Claimed (HH:MM): 45:00
Case Hours Paid (HH:MM): 40:56 Case Hours Not Paid (HH:MM): 07:04
Hours Paid at Overtime Rate(HH:MM): 00:00




Timesheet History Screen ») =

Timesheet History:
|  View Timesheet Details | | | | BVI Timesheet Release/Reject History
Timesheet History List
View 000187138 7/16/2015 8/3/2015  44:01 L':rseirs EL'?I;:& No 8/3/2015  7/27/2015 ':I”;:“:'t‘:r" on CHIPS o peruser
View 000187188 7/16/2015 8/3/2015  44:01 L"r'f;rs Issued No 8/3/2015  7/27/2015 f;;:ll:'t‘:r" on CHIFS g peruser
View 000187188 7/16/2015 8/3/2015 4401 L"r'f;rs EL';;;;( No 8/3/2015  7/27/2015 f;;:ll:'t‘:r" onCHIPS g peruser
View 000187188 7/16/2015 8/3/2015  44:01 L"r'rsesars Issued No 8/3/2015  7/27/2015 ff;:ll:'t‘:'r" onCHIPS ¢ peruser
View 000187188 7/16/2015 00:00 L"r'rsesars Issued No 8/3/2015  7/27/2015 ff;:ll:'t‘;": onCHIPS ¢ peruser
S
Close

When the “History” link is selected from the View Timesheet screen, the
Timesheet History screen is displayed. The “Large Font Timesheet” column has
been added to this screen to indicate the timesheet option.




Forms and Correspondence ))) .
Screen

Forms:
New
Search Criteria A
From Date: [[I/12013 s To Date: |7/312015 [
Search Reset
. BVI NOA
Action Name Language Status Date O_tinn
Mo
View |Edit |Print Change NOA with Slip Page English Printed §/19/2015 Accommodation
is Needed
No
View |Edit |Prnt 50C 858 - Provider Notification - Provider Number i Effective Date 02/01/2015 English Printed 1/5/2015 Accommodation
i5 Needed
Mo
View |Edit |Print Change NOA English Printed 1/5/2015 Accommodation
is Needed

When the “Forms and Correspondence” link is selected from the Cases Left
Navigation pane, the Forms screen is displayed. A new column has been added
to this screen to indicate what option the recipient chose for NOAs.




Large Font Timesheet —
SOC 2261L




Large Font T imeghe_et

&

Provider #

000005002

Case #

Prowder N 129 N
57 01 0001002 ient N

>~ 142000000512

Type IHSS NO
Pay From |05/16/2015 % [05/31/2015 [Hours [18:11
A A
s[ofo][o]o]s17[o]o][o]0]s24] S 31|
Mmolollofolm1s M 25 M| ofol[of o
Tofo|[o]o] T19] T 26 T ofol[o] o
w oo |lofo]fw2o W 27 w/ ol ol[offo
TIofo||lofo]| T21 T 28 T|ofo]|lof 0
Flofo||ofo| F22| F 29| Floloflofo
s16/ 00 |00 s23 S 30 s|ojo][o]o
Total Total Total Total

Turn over and sign =




Recipient Summary Characteristics
Listing Report




Modified Report ») =

STATE OF CALIFORNTIA FREL: 3
COUNTY: IN-HOME SUPPORTIVE SERVICES CYCLE DATE: 08/01/2015 TO 08/31/2015
RECIPIENT SUMMARY CHARACTERISTICS LISTING RUN DATE: 08/12/2015% TIME: 11:23:3¢
CATEGORY TOTAL IHSS CASES CFCO BCSPE IPO IHSS-R
BLIND OR VISUALLY IMPAIERED
BLIND 245 119 121 | 1
VISOALLY IMPRIEED a7 25 42 0 1]
TOTAL 312 144 163 | 1
TIMESHEET OFTION
NO ACCOMMODATICON NWEEDED 235 122 108 4 1
TELEFHONIC SYSTEM 31 g 25 0 0
LARGE FONT TIMESHEET dg lg an 0 0
NOTICES OF ACTION DPTION
NG ACCOMMODATICN NWEEDED 223 119 49 4 1
LARGE FONT NOA ] 20 40 0 0
BRAILLE DOCUMENTS 17 1 lg 0 1]
AUDIG CD 10 3 7 0 0
DATA CD 2 1 1 0

The following new fields have been added to the existing Recipient Summary Characteristics
Listing Report, page 5.
« Blind or Visually Impaired — the count of recipients enrolled with BVI options at the
end of the reporting month.
« Timesheet Option — the count of recipients using different timesheet options.
* Notice of Action Option — the count of recipients using different NOA options (Large
font, Braille, Audio CD or Data CD).



Modified Data Download ») =

The data download has been modified to capture the data elements added to the
Recipient Summary Characteristics Listing Report as described in the previous
slide. The new columns listed below have been added to the

RECIPIENT _MANAGEMENT DATA DATADWLDREC PART 4.csv file

. BVI_TIMESHEET IND

- DELIVERY_OPTION_DESC
- BVI_IMPAIREMENT DESC
- REQ _FORM_DESC




NOAs in Large Font, in Braille and on
Audio/Data CD




NOAs in Large Font )&

COUNTY OF
NOTICE OF ACTION STATE OF CALIFORNIA
IN-HOME SUPPORTIVE HEALTH AND HUMAN
SERVICES (IHSS) APPROVAL SERVICES AGENCY

CALIFORNIA DEPARTMENT

(ADDRESSEE) OF SOCIAL SERVICES

NOTE: This notice relates ONLY to your In-Home Supportive
Services. It does NOT affect your receipt of SSI/SSP, Social
Security, or Medi-Cal. KEEP THIS NOTICE WITH YOUR
IMPORTANT PAPERS.

Notice Date:
Case Name:

Case Number:

Social Worker Name:
Social Worker Number:
Social Worker Telephone:
Social Worker Address:

Large Font NOAs: These documents will be provided in 18-point font to be
more easily read by visually impaired recipients.




NOAs in Braille ))&

Braille: These documents will be provided in the raised-dot Braille
alphabet to allow blind recipients to read the documents.

The standard PDF version of the NOA is viewable in CMIPS by the
county IHSS worker.

Note: Bralille option is targeted for implementation on October 1, 2015.




NOAs on Audio and Data CDs ))) -

|ETATE OF CALIFORNIA
HEALTH AND HUMAN SERWVICES AGENCY
CALIFORNIA DEPARTMENT OF S0OCIAL SERVICES.

NOTICE OF ACTION IN-HOME SUPPORTIVE SERVICES ( I H 5 S ) APPROVAL. COUNTY OF <WVARIABLE=.

The Date of this Notice is <VARIABLE=.

Your Case Name is <VARIABLE>.

Your Case Number 15 <VARIABLE>.

Your Social worker Name is <WVARIABLE>.

Your Social worker Number is <VARIABLE:-.

Your Social worker Telephone Number is <VARIABLE>.

Your Social worker Address is <VARIABLE:>.

Note. This notice relates ONLY To your In-Home Supportive Services. It does NOT affect your receipt of s 51 /5 5P
Your Address is <VARIABLE>.

The total hours and minutes of I H 5 5 you can get each month is =VARIAELE> hours and <VARIABLE> minutes.

Based on an assessment done on <VARIAELE>, wou can get the services in this notice for the amount of time Tisted for

If there is a zero for Authorized Aamount of Service vYou Can Get or the amount is Tess than the Total amount of Servic
Not Meeded means that your social worker found that you do not require assistance with this task. (Manual of Policies
Pending means the county is waiting for more information to determine if you need that service. This notice will pro
services.

Note. Description of each service is later 1in the notice.

For Domestic Serwvices per Month, the Total amount of Serwvice Time Needed 15 <VARIABLE> hours and <VARIABLE> minutes.
The Time for Services yYou Refused or you Get from Others is <VARIAELE> hours and <VARIAELE> minutes. The authorized
Related services per week.

Prepare Meals Serwvice.

The Total amount of Service Time Needed is <VARIABLE> hours and =VARIAELE> minutes.

The Ad?ustment Time for Oothers who Share the Home (proration) is <VARIABLE> hours and <VARIABLE> minutes. The Amount
Meal Clean-up Service.

The Total Amount of Service Time Needed is <WARIABLE> hours and <VARIABLE> minutes.

The Adjustment Time for Others who Share the Home (proration) is <VARIABLE> hours and <VARIABLE> minutes. The Amount
Routine Laundry Service.

The Total Amount of Service Time Needed is <WARIABLE> hours and =VARIAEBLE> minutes.

The adjustment Time for others who share the Home (proration) is =<VARIAELE> hours and <VARIABLE> minutes. The Amount
shopping for Food Serwvice.

The Total amount of Service Time Needed is <VARIABLE> hours and <=VARIABLE> minutes.

The Adjustment Time for Oothers who Share the Home (proration) is =VARIABLE> hours and <VARIABLE> minutes. The Amount
other shopping/Errands service.

The Total Amount of Service Time Needed is <WARIABLE> hours and <VARIABLE> minutes.

The Adjustment Time for Others who Share the Home (proration) is <VARIABLE> hours and <VARIABLE> minutes. The Amount
Non-Medical Personal Services Per week.

Time for the adjustment for Others who sShare the Home (proration) is not applicable for the following serwvices: Respi
Respiration Assistance {Help with Breathing) Serwvice.

The Total Amount of Service Time Needed is <VARIABLE> hours and =VARIAELE> minutes. The Amount of Service Time You N
Bowel, Bladder Care.

CD Audio or Data (Text) Files: These documents will be available as an
audio file that will allow the blind applicant or recipient to hear the
information as it is read or as a data (text) file that can be read to the blind
applicant or recipient by specially adapted computer software.




Telephone Timesheet System
(TTS)




Telephone Timesheet System ))) -

During standard IHSS timesheet processing, each timesheet submitted
is scanned and analyzed. If the provider’s timesheet was signed by the
recipient, the timesheet is processed using standard CMIPS processes
and is generally released for payment.

However, if CMIPS detects a missing recipient signature on a timesheet,
the system will determine whether the recipient is enrolled in the TTS. If
the recipient is enrolled in the TTS, the recipient will receive an

automated call to review and electronically verify or reject the provider’s

timesheet.



Telephone Timesheet System
Assistance Line




Telephone Timesheet System Y)) ..
Assistance Line

If a recipient requires assistance while using TTS, a TTS assistance line
Is available to assist them with timesheet review and the
verification/rejection process.

The TTS assistance line scope is limited to support recipients if they
need assistance reviewing and electronically signing (approving or
rejecting) their timesheet(s). The TTS assistance line can be reached by
a toll-free number at 1-844-576-5445. The TTS assistance line will be
available Monday through Friday from 8 a.m. to 5 p.m. excluding
holidays.



Telephone Timesheet System
Overview




Telephone Timesheet System ))) .
Overview

 [nbound vs. Outbound

 Language Selection

 Authentication

 Review and Take Action on Timesheet
 Review Actions Taken on Past Timesheets




Telephone Timesheet System
Demonstration




Telephone Timesheet System ))) ..
Demonstration Scenarios

Scenarios to be covered in the TTS Demonstration:

« Authentication
v Unsuccessful (Incorrect Case Number or RAN)
v Unsuccessful (Incorrect Case Number or RAN length)
v Successful

* Review of Pending Timesheet
v Summary Review
» Approval
v’ Detailed Review
» Rejection

 Review of Historical Timesheets
v' Summary Review
v' Detailed Review




BVI Services Training and
Outreach




BVI Services Training M) «
and Outreach

CDSS has provided the below training materials to counties:

» TTS training CDs
> Brallle Stickers
» TTS Outreach Scripts

Key Points to remember during training and outreach:

Recipient’s Case Number: remind the Recipient the Case Number is 7
digits.
When using the TTS, the recipient needs to state each number individually.
For example: for number 0001445

Say this: zero zero zero one four four five

Do not say: zero zero zero fourteen forty five
Recipient’s phone number
Recipient’s mailing address
Recipient Authentication Number (RAN) if already created
Reminder: County should also notify the assigned Provider(s) that the
Recipient has signed up for the TTS.



References N«

 BVIACL 15-60

 Informational Notification: IHSS BVI Services Implementation
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« For BVI webinar related questions, please send your inquiries to:
CMIPSII-Requests@DSS.CA.GOV
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Questions? RN
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Thank youl!




